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Jerome® Communications Software (JCS)

To be used with:
Jerome® 431-X Mercury Vapor Analyzer with the Communications option and

Jerome® 631-X Hydrogen Sulfide Analyzer with the Communications option

AZI Jerome Communications Software ] - IE] |i]
File Setup Datalogger Data Instrument Window Help |

Ready [ [ fkaes[ NoM[ [ 4

PROPRIETARY RIGHTS NOTICE

The material in this manual contains valuable information developed by Arizona Instrument

LLC for use with the Jerome® line of analyzers. No part of this manual can be reproduced or

transmitted in any form or by any means, electronic, mechanical, or otherwise. This includes

photocopying and recording or in connection with any information storage or retrieval system
without the express written permission of Arizona Instrument LLC.

A current electronic copy of this manual can be found on the AZI website at:
www.azic.com/downloads.aspx

© Copyright 2000-2009, Arizona Instrument LLC. All Rights Reserved.

Windows® and Access® are registered trademarks of Microsoft Corporation in the United
States and other countries.
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1.  INTRODUCTION

The Jerome® Communications Software (JCS) operates with the Jerome® 431-X Mercury
Vapor and Jerome® 631-X Hydrogen Sulfide Analyzers that have the Communications option
installed. The software can control instrument sampling for unattended continuous operation,
collect data, graph this data in real time and perform statistical analysis.

The software can also program the Jerome® Data Logger, AZI P/N 6100-0010. This optional
accessory enables data storage during manual sampling or portable automatic sampling,
without being attached to a computer. The Data Logger initiates automatic sampling, triggers
alarms and stores data. The logged data may then be downloaded to the computer when it is
convenient.

The JCS software is menu-driven and easy to use. Each display screen is designed for clarity
with self-explanatory menu options. Select menu options using either a mouse/pointing
device or a standard keyboard. The user creates records, or files, for computer storage of
collected data. Data is easily retrieved for later viewing, graphing, printing or editing with
spreadsheet or word processing software (not provided). Data can be used for ongoing record
keeping or for fulfilling local regulatory requirements.

Before using this software, familiarization with the operation of the Jerome® Hydrogen
Sulfide Analyzer or Mercury Vapor Analyzer is important. Prior to installation of this
software, familiarity with the personal computer and Windows® operating system being used
is also recommended. If you have any questions about how to proceed, call AZI Customer
Service at (800) 528-7411 or (602) 470-1414 or send an e-mail to support@azic.com for
assistance.
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2. SYSTEM REQUIREMENTS

Contents of the JCS Kit (AZI #Y990-0168)

Jerome® Communications Software (on CD-ROM)

USB Security Key

JCS (Instrument/Data Logger/PC) Interface Cable, AZI #6000-1055
This user’s manual (also on the CD-ROM)

Files on the JCS Program CD-ROM
JCS installation program
JCS and instrument manuals current at the time the software shipped

System requirements, not included with the JCS Kit
Jerome® 431-X or 631-X with the Communications Option installed
Windows® 98 Second Edition, Windows® ME, Windows® NT, Windows® 2000 or
Windows® XP
One available DB9/RS-232 serial port
One available USB port

Optional equipment:
Jerome® Data Logger, AZI P/N 6100-0010 (to capture data without a computer
nearby)

WARNING:
A standard serial cable should never be used with the Jerome®
instruments.

The specially designed JCS Interface Cable (AZI part number 6000-1055)
uses only four wires between the computer and the instrument. Standard
serial cables use more wires and could damage the computer or instrument.

10° 2'

/

Ll
—_—

~dsl
— ST

DBY9 CONNECTOR
TO COMPUTER

DB25 CONNECTOR
TO INSTRUMMENT

DB25 CONNECTOR TO DATA LOGGER

JCS Interface Cable (AZI #6000-1055)
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HARDWARE INSTALLATION

After the software is installed and operating, the security key will be installed

3
f Please Note: Only the JCS Interface Cable should be installed at this time.
— [ inanavailable USB port.

3.1. Instrument to Computer - Direct Interface

Use the direct interface configuration when the Jerome® instrument is connected directly to a
dedicated computer. The JCS allows the computer to control sampling, data storage and data
analysis while connected directly to the instrument.

Please Note: This configuration will not operate if the Data Logger is
attached to the center connector of the JCS Interface Cable.

e Ensure the computer and instrument are both turned OFF.

e Locate the DB25 connector marked “INSTRUMENT” on the JCS Interface Cable and
attach it to the back of the e
instrument.

e Attach the DB9 connector
on the other end of the

DB25 Instrument

cable (identified as “PC”) Connector
to an available serial port Installed

on the computer. This port .

will be identified to the in Analyzer

JCS during program
installation.

e The remaining DB25
connector on the cable
must not be connected. It
is used only during
programming of the Data

| DBQ PC Connector

Logger. When it is Installed in
connected, it will inhibit : CompuTer
all communication O ,

between the instrument W Serial Port

and computer.
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3.2.

Instrument to Data Logger to Computer Connection

This configuration is used for Data Logger setup and configuration. After programming the
Data Logger, disconnect the cables and attach the Data Logger directly to the instrument. The
Data Logger can then control analyzer sampling, alarms and data storage. The Data Logger
has a 1,000 sample data capacity. The Data Logger must be reconnected to the computer to
download the data.

Please Note: The Data Logger will not operate if it is connected to the JCS

Interface Cable. It must be connected directly to the instrument to receive
power from the instrument and perform auto-sampling and data storage.

Ensure the computer and instrument are both turned OFF.

Locate the DB25 connector marked “INSTRUMENT” on the JCS Interface Cable and

attach it to the back of the instrument.

Attach the DB9 connector on the other end of the cable (identified as “PC”) to an
available serial port on the computer. This port will be identified to the JCS during

program installation.

Connect the remaining DB25 connector, identified as “DATA LOGGER,” to the Data

Logger. (This connector has two cables extending from it.)

DB25 Connector
Installed in
Instrument

DB25 Connector
Installed in
Data Logger

DB? Connector
installed in
Computer
Serial Port

AZI Customer Service 602-470-1414, 800-528-7411, or support@azic.com
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4. SOFTWARE INSTALLATION

4.1. Starting the Software

e Turn on your PC and place the JCS Software CD into the computer’s CD drive. If the
program fails to start:

> Select Startand Run.
» Enter E:\Instal\JCS _Install.exe,

where “E” is the letter identifying ARIZONA INSTRUMERNT LLC
the CD drive, and select OK. Copyight 2002 2003

‘ Install Jerome Communications Software I

e Click on “Install Jerome

Communications Software” to install L oo |

the software or “Close” to abort the

installation.

43, AZI Jerome Clommunications Software Setup il

) Ensu re al I other ru nn i ng prog rams are @ gilgtér:: i the 471 Jerome Communications Saftware installation

Closed before Cllelng on “OK’ 7 or Setup cannot install system files or update shared ﬂ.les .if they are in use. Before

Clle on “EXlt Setup” tO abOI‘t the proceeding, we recommend that you close any applications you may be running.

installation.

oK | Exit Setp

[} Click on “Change Directory” if you 43 AZI Jerome C'ommunications Software Setup x|
Want the Software to i nstal I i na Begin the installation by clicking the button belo,
d iﬁerent d i reCtO ry or fo I der than the % Click this button to install AZI Jerome Communications Software software to the
d efau It d i re Cto ry . = specified destination directory.

e Click on the picture button to install the

software to the listed directory, or click ﬁfﬂif;f;mﬁm = |
on “Exit Setup” to abort the

installation. —
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o C(Click on “Continue” to add the AZI 43, AZI Jerome Communications Software - Choose Progr ill
Program Group and AZI icon to the S SRS 2 1crrc CominLricaiions Software
Computer’ S Start Menu If deS| I’ed type can enter a new group name ar select one from the Existing Groups list.
in a different program group or click on
“Cancel” to prevent the addition of the Brogram Group;

AZI group to the Start Menu. =

Existing Groups:

e The software may take several seconds Acressories

Administrative Tools

to load, depending on the speed of your
. . Lavasoft Ad-aware
computer and disk drive. Startup

\Wehshots Desktop!
Windows Media Player Bonus Pack

Continue I Cancel |

e If Microsoft Access® 2000 database x|
Software SRl or Iater |S |nsta”ed on Faound Microsoft Access 2000 Wersion: 9.0.0.4506

Access Funtime will nat be installed.

your computer, no additional software
will be installed by JCS. If Access®
2000 database software SR1 or later is
not installed on your computer, then
Access® Runtime will be installed. This screen will indicate what program was found
and what action was taken.

NOTE: When installed on Windows® XP, Windows® 2000, or Windows® NT operating
systems, the computer user must have read/write access to the "\Program Files\AZI JCS"

directory. See your network administrator or the operating system help files for assistance in
setting rights.

The software may be loaded on as many computers as desired but will operate in a
“demonstration” mode on all but one. The software will be fully functional on the one
computer that has the “security key” installed in a USB port. The security key is installed
after the software has been installed, as detailed in the next section.

AZI Customer Service 602-470-1414, 800-528-7411, or support@azic.com Page 9 of 24



4.2. Security Key

As soon as the JCS software installation is
complete, insert the USB security key into an
available USB port. The computer will
automatically detect the key and install drivers
that were copied into the computer during the
JCS installation. The Data Logger and
Instrument menu items are only available while
the key is installed. The key can be moved
from computer to computer. However, only
the computer in which it is installed will be
capable of full program operation.

1Security Key
i Installed in
*USB Port

Computers that have the software installed but no security key installed will operate in a
demonstration mode only. No data can be transferred to or from the instrument but data
previously stored in the computer may be viewed.

4.3. Using the Software

AZI Jerome Communications Software

Click on Start->Programs (or All Programs)=> G seup batalogger Data Instrument Window Help

AZ1-> JCS to launch JCS. The screen shown
to the right appears, along with the help screen “
shown below. The JCS program operates . M.
according to Windows® conventions for menu Arizona Instrument
driven programs. Selections are made with a /
mouse/pointing device or keyboard. Set the
cursor on the desired selection and click to
select the item. The Windows® keyboard

“Alt,” arrow, “Tab” and “Enter” keys may also
be used.

The Program Window has the typical drop- Ready [ [ [ [caps|  NM[ | g
down menu bar across the top of the screen to
access program options, commands and

E? JCS Help _ (O] x|

information. =
SE -
Hide Back Frint Options

Eontens QUICK START GUIDE :’

[E] Auto Sample

5 Data PROGRAM

[E] Data Logger Programming CONFIGURATION

[£] Data Logger Data Retrigval

@ Impart

[] Instrument Checks Set_up the PC's

@ Instruments serial pOI‘t

[E Program Configuration number by

E Fequirements selecting the

Record Edit Policy .

21 Security Key Conﬁ_guratlon

H sites menu item (See

[5] Technicians below) to open
the Program
Configuration
form. hd

4 4

Page 10 of 24 AZI| Customer Service 602-470-1414, 800-528-7411, or support@azic.com




4.4. Program Revision Information

Click on “Help” on the menu bar then click on “About.” The AZI logo appears and shows the
program'’s title and version number. If you call AZI Customer Service for any reason, this
version number will be needed to identify the software in use.

¥ AZi Jerome Communications Software

ES About AZI JCS

Arizona ing

Arizona Instrument
AZI Jerome Communications Software

Version 1,02
Copyright 2002, 2003 Arizona Instrument LLC

Form View

5.  JCS Menus

5.1. File menu

e Compact Database — clicking on this option compacts the AZI Jerome Commu..
database to take up less disk space, if desired. \Fle Setup DataLogger Data

Compact Database
e Configuration — Sets up the options shown below. Configration
> Data Logger — Double Check High Readings - Click on et eIeoe 7.9
this check box if the Data Logger is to be programmed to &' page Setup.
take another sample immediately to verify a high reading.
> Display Help on Startup — Check this box if you want

the Help file to be displayed each time the
program is started. It is best to check this box
until you are familiar with the functions you

E AFTI Jerome Communications Software

B85 Program Configuration

Data Logger - Double Check High Readings: ¥

need to perform on a routine basis. Sl 0 Sy
» Report Header Lines — Type the information Report Header Lines
you want to appear at the top of each printed Report identifer

report in these three lines. You do not haveto | |
use all of them. |
» Export Directory — Enter the directory on the

hard drive where you want data and reports ExportDirectry: [C: Program Flesiazl 155
stored. The default selection stores the data in spertFarmnst; Moeohecesl L
the directory with the Jerome® sertl Forthuror: 8 =
Communication Software program. _ oo |

K|

[Form wiew |_
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» Export Format — Choose the output format that best suits your needs.
» HTML - for web browser use,
» Microsoft Excel - for spreadsheet use,
» RTEF - for general word processing use, and
>» Text - for notepad use.

> Serial Port Number - Select the AZ] Jerome Communications Software il
computer’s serial port number, - , ,
24 The selected communications port is not available.
usually 1 or 2. If the computer has <’ Do you want to select another port?

a modem, serial port 3 or 4 may
need to be selected.

Mo | Cancel |

e Import DOS JCI File — If there are files created by the DOS version of Jerome®
Communication Interface software on the system, use this option to bring them into
the current Windows®-based software.

e Page Setup, Print, and Exit — The last three selections under the File Menu are
standard program options to control printing operations and exiting the program.
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5.2.  Setup menu

The JCS program uses Microsoft Access to store information. The data from the Data Logger
is stored in records that are associated with site/location records, instrument records, and
technician records. Before retrieving new data from the Data Logger, the site, instrument, and
technician records must be set up.

e Instrument Checks — provides a place to enter the data from periodic checks of the
instrument.

e Site —displays a form to enter site data. Enter the site name, address and sample
location. Add all of the sites that are monitored. Each site must have at least one
sample location specified and can have up to as many locations as are used at the site.
Instruments — enter the name, model and serial number of each instrument used.

e Technicians — enter the names of the technicians that will be using the software or
instruments. If a name is misspelled and corrected at a future date, the correction is
applied to all previous data records.

AZ| Jerome Communications Software

File Setup Datalogger Data Instrument  Wwindow  Help Twpe a question for help =

13

B Instrument Checks

Instrument [ Date Techniciar: [Mr Brawn ~
Jim's 631, 631+, SN 1004 % Oct-16-2002 .
Jiri's 631, 631:%, SN 1004 Oct-14-2002 el IR
Fathy's B31, B3, SN 1021 Oet-16-2002 2. Fun 3 blanks [Must be 0.002 or less)

[t | [

3. Function Test Module Readings

el |

ET |

B Sites

Address:
I'I 912 W ater Bled.
|F'hoeni:-c, AZ Bages

Site Mame
Phoenix  Water Treatement Plant
Tempe *Water Treatment Plant

Record: E 4 I_

Tubing Okay [Mo Twi

Fritwaar

Comnment; I
Cloze |

E= Instruments : B Technicians

Sample Location
N Fence
Scubber

ia
E3

Narne [ Model [ Serial Number
Jim's 631 E31-H 1004
Kathy's 631 E31-H 1021

r Brawn

[<

Farm View FLTR MUM
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5.3. Data Logger menu

The Data Logger is used to collect the data from the instrument, but first it must be
programmed.

To program the Data Logger:
Connect the JCS Interface Cable as follows:
e Attach the connector marked “DATA LOGGER” to the Data Logger.

e Attach the connector marked “PC” to the computer.

e Attach the connector marked “INSTRUMENT” to the instrument.

e Turn the instrument ON.

e InJCS, click on the “Data Logger” AZI Jerome Communications Software =1o] %]
drOp-dOWﬂ menu, and then CliCk on File Setup Datalogger Data Instrument Window Help |
“Program.” Data Logger - Program

e The Program Menu allows setting of ! Sample Interval (00 60y min: [T
the sample interval and alarm setpoint £ Alarm Setpaint [05
value into the Data Logger. Ariza BT ) e
» Do not use a short Sample Interval '

FProgramming the Data Logger
erases existing store datal
Leave Data Logger powered up fora
couple minutes to charge hattery.

Brogram |
Close |

Formvew [ [ [ [ [ W[ | [

that would require more than 2
regenerations per day. Try a 10 to
15 minute sample interval initially.

» Set the Alarm Setpoint if desired or
leave it blank. A blank alarm
setpoint has the effect of turning off
the alarm.

» Click on the Program button to set
the values into the Data Logger.

e Disconnect the JCS Interface Cable from the instrument and Data Logger.
e Attach the Data Logger directly to the instrument.
» The Data Logger can be left unpowered for a few hours without losing its time
clock. Turn the instrument on every few hours for a few minutes to power the
Data Logger and retain the clock and programming.

When you are ready to begin sampling:
e Turn the instrument ON
e Press the sample button.

When finished sampling:
e Turn the instrument off.
» Remove the Data Logger from the instrument and attach it to the JCS Interface
Cable connector marked “DATA LOGGER.”

» Ensure the JCS Interface Cable’s “PC” connector is still attached to the computer.
» Connect the JCS Interface Cable connector marked “INSTRUMENT” to the
instrument.
» Turn the instrument ON.
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e Click on “Data Logger” and then on
“Retrieve Data.”

e Select the information for this sampling
session from the pull down tabs for
each line.

e Ensure the date and time are correct.

e Addacomment if desired.

e Click on the Retrieve button.

» Data files stored in the Data Logger
will be transferred into the
computer.

e After the data is in the computer, the
program loads the Data Form to allow
you to view the data on-screen.

AZ] Jerome Communications Softsware

File Setup Datalogger Data Instrument Window Help |

Data Logger - Program il|
4

ES Data Logger - Retrieve Data

Site And Location:  |Silel=] ater Treatement Plant, Scrubijig

Technician: |MrEir0wn

L] L]

Instrument; IJim's 631, 631-<, SN 1004

Date/Time: |Jan—1 F-2003 10:07am

Cornment: I

Betrieve

i

Close

Forrm Yigw e e 7
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5.4. Data menu

Click on Data on the menu bar to view or export data records.
e Select the record you want to view or export from the list.
» The address, technician, instrument and alarm setpoint and comment for the
selected record are displayed to the right of the selection list.

AZI Jerome Communications Software

Fle Setup Datalogger Data Instrument Window Help ‘

Site And Location | Date{Time Address:
- Treatement Flan [ C'=c-31-2002 5:22am |1 017 Water Blvd,

|Phoeni>¢ AZ BRASE

Technician: |Mr Brown

L] L]

Instrument: |.Jim's 631, 631 SN 1004

Alarm Setpaint; I

Comment:
Record: I1| 4 II 1k IPI |H€| of 1
Close | “Wiew Bepont | Wiew Graph | Export Repart |

|FDrm Wiew I—’—|_| | ’W| ’_ A

Click on View Report or View Graph buttons display the data.
e To view the report:

¢ Click on the View_ Report BUtt_O_n' AZl Jerome Communications Software |
e If an Alarm Setpoint was specified,

then click on either Yes or No to P :
C - & Display alarm readings only?
answer the question “Display alarm \-\r)

readings only?” If you click on yes
and there are no readings above the
alarm setpoint, the “Insufficient test
data to display” message will be
displayed.
e To exit from a report or graph, press the
ESC key on the computer’s keyboard.
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A sample report is shown below.

Site Name: Doc Control

Sample Location:

Above R&ED Lab

Address: 1912 W 4th Street Technician: Jirm Ed Brown
Tempe, AZ 85281 Instrument: Kevin's' 431, 431-%, 5N 3190
Comment:
Date/Time: Jan-20-2003 12:51pm
Alarm Setpoint: 0.023  (mgin3)
DATE/TIME RESULT (mg/m*3) Page 1 of 1

1 Jan-20-2003 12:52:30pm 01
2 Jan-20-2003 1:07:290m 009
3 Jan-20-2003 1:22:290m 034
4 Jan-20-2003 1:24:290m 014
5 Jan-20-2003 1:39:290m 010
6 Jan-20-2003 1:54:290m 039
7 Jan-20-2003 1:56:29nm 010
Readings: 7
Minimum: 0.009
Maximum: 0.038
Average: 0.018
SD: 027

An example graph is shown below.

Site Name: Doc Control

Address:

1912 W 4th Street

Tempe, A7 35251

Sample Location:
Technician:
Instrument:

Above R&D Lab
Jim Ed Brown
Kevin's' 431, 431-%, 5W 3130

Comment:

Date'Time:
Alarm Setpoint:

Jan-20-2003 12:51pm
0023 (mg/m*3)

Result (mg/m*~3)

0.045 1

0.040 1

0.035

QLB evererraemmmmiiiemiiine,

o

o

]

i3]
)

]

)

b

o
!

0.015

0.010

0.005 4

0.000

Jan-20 12PM

Day

AZI Customer Service 602-470-1414, 800-528-7411, or support@azic.com
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Export Report — Sends a copy of the report (in the file format specified in the

File->Configuration menu) to the directory specified in the File->Configuration menu.

Deleting or Editing Records

To delete or edit records, JCS uses the Microsoft Access database and therefore, record
additions, deletions, and edits are performed using Access policies:

Delete — Delete unwanted records by selecting the record selector arrow on the left of
the record and press the Delete key on the computer’s keyboard. A reminder will
appear indicating that the Delete cannot be undone. Press Yes to proceed or No to
cancel. Please note that a record cannot be deleted if it is associated with other
records. For example: a technician record cannot be deleted if it is referred to by a
Data record. Delete the Data record first, then delete the technician record. If the data
record must be maintained, the technician information will be maintained as well.

Edit — Edit the fields of a record by typing in the desired field. The edits are saved
when the form is closed. If a field is edited, the correction is applied to all previous
data records. For example, after the address is changed, newly printed reports will
have the corrected address. Edits can also be made from the appropriate selection in
the Setup menu. For example, select Setup—> Technician to edit the Technician list.
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5.5. Instrument menu

The Instrument menu is used to program the
computer to control the sampling rate of the
instrument when the instrument is connected
to the computer. The JCS Interface Cable
passes the control signals to the instrument
and data to the computer.

File Setup Datalogger Data | Instrument Window Help

X ‘,! .7, .

Ready T T R

e Auto Sample

>

The Site and Location, Technician, ERGEENG

and Instrument records must be set Site And Location: [Doc Contral, Above FiéD Lab ]
up in the Setup menu prior to Auto- Technician: [Jim Ed Erown =1
Sampling_ Instrument: |Kevm's' 431, 431-%, SN 3180 ;l
Enter the Sample Interval in Sample Interval (1 0 60y min: [15

minutes. Do not use a short sample Alarm Setpoint [1023 E1X(0010 999 ma/m3
interval that would require more

than 2 regenerations per day. Trya = mieveSemonenal [

10 to 15 minute sample interval Dete{Time: |Jon 202003 1251pm

initially. camment |

If an unsafe or critical level is ﬂ

known, enter that level in the Alarm

Setpoint field.

Click on the Start button to begin

sampling.

[ Num | Date/Time | Result ]
Jan-20-2003 2:10:30pm 010

The Test Data form opens and m
displays the current samples as they
are received from the instrument.
The Time to Next Sample box will
appear and show a running time
remaining until the next sample will
be taken. When a sample is being
taken, the time is replaced with the
word NOW.

Clicking on the View Report or
View Graph button, after at least
two samples have been taken, will immediately display the collected data currently
in the database.

Close | “iew Beport | View Graph |

AZI Customer Service 602-470-1414, 800-528-7411, or support@azic.com Page 19 of 24




> If the alarm level is exceeded, the alarm will sound through the computer and the
screen will display a flashing warning message as shown.

=l AZ1 JCS

WARMNING! prm
The &larm Setpoint has been exceeded!

Stop Time to Mest Sample; | 414

e Take One Sample
» Click on Take One Sample to direct the instrument to take a sample. This
selection has the same function as the SAMPLE button on the instrument. The
measured concentration will be displayed. If desired, press the “Sample Again”
button to take another sample.

[ = =
Sample Reading
@ Sample walue is 000 {ppm).
Cisel | sempleagan
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5.6. Window menu

e This selection operates as it does
in many other Windows®-based
programs. It tiles open windows
horizontally or vertically or
cascades them over each other.

B2 AZI Jerome Communications Software
Fle Setup Datalogger Dats Instrument

Site Name
7| Phoenix Water Treatement Plant
Tempe Water Treatment Plart

Blvd
88888

Sample Location ]
N Fence
Scrubber

Record: (1) « [ 1 DJOURH of 2

Close.

Record: (1) < [ 1 (2 J0LpH) of 2

Close

UM

Form View

5.7. Help menu

e Selecting “Contents” in the
Help menu brings up the Help
contents listing with a brief
explanation of those items
necessary for successful
program operation.

» The Quick Start selection
in the Contents listing has
hyperlinks built into it that
can be clicked to navigate
to the hyperlinked sections.

e The Help menu can be set to
display automatically at
program startup by checking
the “Display Help on Startup”
box in the File->
Configuration window.

E? JCS Help _ 3] x]

] <= = E~
Hide Eack Frint Options

QUICK START GUIDE i’

[ Data PROGRAM

[£] Data Logger Programrming CONFIGURATION
[£] Data Logger Data Retrieval

A import Setup the PC's

[E] Instrument Checks

[E1 Instrurnerts serial port

[£] Program Configuration number by

E Reguirerments selecting the

Record Edit Policy .

[ Security Key Conﬁguratlon

B Sites menu item (See

[E) Technicians below) to open
the Program
Configuration
form. -

d »
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Operation

6.1.

Instrument operation from the computer

Connect the JCS Interface Cable’s
“PC” connector to the computer and the
“INSTRUMENT” connector to the
instrument.

Ensure that the middle connector is not
attached to the Data Logger.

Launch JCS on the PC.

If all preliminary set-up procedures
have been completed and the
instrument is turned ON,

Click on Instrument.

Click on Auto Sample.

Select the Site/Location.

Select the Technician.

Select the Instrument.

Enter or verify the Sample Interval.
Enter or verify the Alarm Level.
Add a comment if desired.

Click on the Start button.

DB25 Instrument
Connector
Installed

in Analyzer

¢ | DB? PC Connector
& Installed in
Sy Computer

¥ Serial Port

VVVVVVVYVYY

The instrument should take one sample within a few seconds and repeatedly thereafter
at the preset rate.
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6.2. Instrument operation from the Data Logger

e Ensure the instrument is turned OFF

e Connect the JCS Interface Cable’s “PC”
connector to the computer, the “DATA
LOGGER?” connector to the Jerome®
Data Logger, and the “INSTRUMENT”
connector to the instrument.

Installed in
Instrument

DB25 Connector

Installed in

e Launch the JCS program on the PC.
Data Logger

e If all preliminary set-up procedures have
been completed,

Turn the instrument ON.

Click on Data Logger.

Click on Program.

Enter the Sample Interval and Alarm

Setpoint.

Click on Program.

e Turn the instrument OFF

e Disconnect the JCS Interface Cable from the instrument and from the Data Logger.

e Connect the Data Logger directly
onto the instrument. (o o

e When the instrument is at the I o |
location for sampling: P —
» Turn the instrument ON.
» Press the Sample Button on the

DB? Connector
installed in
Computer
Serial Port

YV VVVYVY

instrument. . @ ©

e When sampling is complete: 5
» Turn the instrument OFF. JERO | i

» Remove the Data Logger from DATA ACQUISITION SYSTEM

the instrument. AZi

» Connect the JCS Interface

Cable’s “PC” connector to the

computer, the “DATA LOGGER” connector to the Jerome® Data Logger, and the

“INSTRUMENT” connector to the instrument.

Turn the computer on if necessary, and launch the JCS program.

Turn the instrument ON.

Click on Data Logger.

Click on Retrieve Data.

e The data from the Data Logger will be placed in the database and be available for
review and/or printing.

e Turn the instrument OFF and remove all cabling when finished.

YV VYYVY
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TRADEMARK AND COPYRIGHT PROTECTION

Jerome®, Arizona Instrument® and the stylized AZI are all registered trademarks of Arizona
Instrument LLC. Instrument firmware and software is copyright protected.

© Copyright 2000-2009, Arizona Instrument LLC. All Rights Reserved.

Windows® and Access® are registered trademarks of Microsoft Corporation in the United
States and other countries.

Arizona Instrument LLC

Jerome® Communication Software Installation and Operation Manual
AZI P/N: 700-0042-B

May 2009

If you have any questions regarding the operation of this instrument, please call 800-528-
7411, 602-470-1414, fax 480-804-0656 or send e-mail to support@azic.com.

Arizona Instrument LLC
3375 N Delaware Street
Chandler, AZ 85225

(800) 528-7411
(602) 470-1414
Fax (480) 804-0656
http://www.azic.com

email:

azi@azic.com - General
intl@azic.com - International

support@azic.com - Customer Support
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